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Digital Dave
“Digital Dave answers your tech questions.” by Digital Dave 
 

Format an Internal Hard Drive to Reinstall Window XP; Microsoft Word; Replacing My Hard Drive 
with a Solid State Drive.

 

 
Dear Digital Dave, 
 
I have a computer where I want to replace the software that is installed on it (Windows 7 
Ultimate) because when I connect this computer to the Internet through the cable company, I 
receive a lot of notifications about viruses infecting my computer—even after I installed Norton 
360. By the way, the Internet services offers protection for the computer. I wonder how my 
computer got infected. I would appreciate it if you could illuminate me with advice on how I can 
format this hard drive and go back to Windows XP. 
 
Thank you and Happy New Year to you, 
 
Noe Villegas 
Chula Vista, California 
 
Dear Noe, 
 
You may be jumping to conclusions about Windows 7. While it is possible that you have a virus, it not likely related to 
Windows 7. In my opinion, it is always a mistake to go back to Windows XP. If you're using Windows XP now, I 
wouldn't force you to upgrade, but once you make the jump it will be worthwhile to persist. 
 
You say that you get the virus warnings when you connect to the Internet. These could easily be scam warnings 
generated by Web sites hoping to get you to buy their fake virus scanning software. They are not likely related to 
Windows 7. 
 
One of the first things I do on a new Windows computer is remove any antivirus software that comes with the 
computer, such as Norton's. For some reason, I get many similar questions about security warnings when Norton's is 
installed. (Don't know why.) I then download, install and run the free Microsoft Security Essentials (windows.
microsoft.com/en-US/windows/products/security-essentials). I've used this program for years on a 
number of computers with no problems. (Of course, I also practice good computer hygiene.—careful about e-mail, 
downloads and links.) 
 
You should also note if you are accessing certain Web sites when you get these warnings. I would try alternative Web 
browsers such as Mozilla Firefox (/www.mozilla.org/en-US/firefox/new/) and Google Chrome (www.google.
com/chrome). Sometimes the problems are in browser add-ons. 
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If you feel the need to reinstall any software, do it with Windows 7. You should be able to insert the installation disc 
and proceed from there with a clean installation. If you have any important data on the computer, you should back it 
up to a disc or USB drive before you do this.  
 
The only benefit that you would get from reinstalling Windows XP is the nostalgic comfort you may get, like from an 
old, worn blanket. There are many benefits to Windows 7, but you will never see them if you stay with XP. 
 
If you want to understand the differences between Windows XP and Windows 7, I see that ComputorEdge E-
Books addresses the topic in the e-book Sticking with Windows XP—or Not? (computoredgebooks.com/
Windows-Tips-and-Tricks_c4.htm).  
 
Digital Dave 

Dear Digital Dave, 
 
Microsoft Word has started giving me grief when printing. At first it was once in a while, but now 
it is a permanent fault with all my documents. When I try to print I get a message that says "The 
instruction at 0x00440020 referenced memory at 0x00000022. The memory could not be 
written. Click on OK to terminate the program." I tried printing from Print Preview and that 
worked for a time, but now it gives a similar error message, but with memory location 
0x80000000. I copied the document into OpenOffice, and it prints fine. What's going on? 
 
Donald R. Hicke 
San Diego, CA 
 
Dear Donald, 
 
The fact that everything works in OpenOffice.org and the errors just started recently indicates that the problem likely 
lies with Microsoft Word. Possibly your installation is corrupted in some manner. The error you're seeing is often 
related to output or copying problems. In these situations it is usually best to reinstall the offending software. In some 
cases you may need to uninstall Microsoft Word before reinstalling it. 
 
Another alternative is to switch to OpenOffice.org, or even better (according to feedback from readers) the also free 
LibreOffice (www.libreoffice.org/), which is a fork of OpenOffice.org. Since being turned over by Oracle, 
OpenOffice.org is now in incubation with The Apache Software Foundation. Time will tell if it will get the necessary 
Open Source support. With the rapid rise in popularity of LibreOffice, OpenOffice may not get the necessary support 
to continue. Time will tell. 
 
It may be annoying for me to suggest another product when you most likely paid for Microsoft Word or may be 
required to use it for business reasons. However, if the simpler uninstall/reinstall solution doesn't fix things, I've found 
that hours can be wasted looking for a good solution. Although, you might try running CCleaner (www.piriform.
com/ccleaner) registry cleaner between the uninstall and reinstall of word. This could clean out stray remnants of 
Word in the registry making a cleaner install. 
 
Digital Dave 

Dear Digital Dave, 
 
I'm using a Lenovo G550 laptop as my PC. It has a 250GB hard drive that I know will fail 
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sometime in the future. Is there a solid state hard drive replacement that I could buy and install 
to prevent this and speed up my PC? 
 
Thanks! 
 
Mike 
Cardiff, CA 
 
Dear Mike, 
 
You may be able to find a Solid State Drive (SSD) which will fit your computer, although I was not able to find one for 
the Lenovo G550. Your best bet would be to talk directly to Lenovo. While solid state drives act in the same manner 
as hard drives, it is important that you find one that mechanically fits into your computer (same connector) and runs 
with your operating system. Don't buy any SSD unless you can confirm that it will work with your laptop. 
 
Even if you do find one, that does not preclude drive failure. A solid state drive is essentially a memory device, similar 
to a flash drive, which has been configured to act like a hard drive. Since it has no moving parts, it is not subject to 
mechanical failure the way a hard drive is. It is also five to ten times faster than a hard drive and makes no noise. 
However, although rarer, SSDs are subject to electronic failure (as are all electronic components) and memory 
deterioration over time. While failure is much less likely with SSDs than hard drives, it is not absolute protection. You 
will still want a good backup system. 
 
Another advantage to the SSD is that many of the standard features of Windows computers, such as disk 
defragmentation, are no longer required. Since there is no mechanical movement in the SSD, fragmented files do not 
slow down the access speeds. (Defragmentation is automatically disabled in Windows 7 and should be manually 
disabled for earlier version of Windows. Defragmentation programs can actually shorten the life of SSDs without 
giving any benefit.) 
 
The main obstacle holding back SSDs as standard equipment in new computers is the price when compared to hard 
drives. A 250 gigabyte SSD may cost $400 to $500 dollars, whereas a same size hard drive can be found for as little 
as $50. When the price comes down enough, it's likely that most computers will come with solid state drives. 
 
I know that Seagate has a hybrid solid state/mechanical drive, but it doesn't resolve the problem of mechanic drives. 
It does speed up loading of the operating system and programs (not as fast as SSD), but is no help when working 
with drive intensive applications such as video editing and database searches. It would certainly be just as 
susceptible to failure as a standard hard drive. 
 
At this point, unless you need the increased speed of an SSD, I would lean toward adding a standard USB hard drive 
for backup and using Internet Cloud backup as protection against a hard drive failure. You're right that the hard drive 
will eventually fail, but it could be years before that happens. Getting a backup hard drive will save a great deal of 
money. You still need the backup—even with a solid state drive. 
 
Digital Dave 
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Windows 7 Is Here to Stay! Who Needs Windows 8?
“The Future of Windows 7” by Jack Dunning 
 

Jack predicts that Windows 7 will be around for a long time after Windows 8 is released. People are skeptical after the Vista 
fiasco that Windows 8 is trying to do too much.

 
 
Looking at the trends in computers it becomes obvious that operating systems are reaching a more mature stage. No 
longer does the release of a new OS or new version of an old OS cause a stampede to buy or upgrade. The 
introduction of a new version of Windows is greeted with "Maybe I will and maybe I won't." Windows XP continues to 
be a force in the desktop world because it still works. It's good enough. Any excitement about a new release of 
Windows was killed by Windows Vista. Now we cautiously move from one computer system to another. 
 
As is shown by this graphic (Figure 1) from Net Market Share (www.netmarketshare.com/operating-system-
market-share.aspx?qprid=11&qpcustomb=0&qptimeframe=M&qpsp=144&qpnp=13), it will still be a 
number of months before Windows 7 overtakes Windows XP in desktop operating system installations. It's been a 
pretty steady trend with the vast majority of Windows XPs being replaced with Windows 7. While still declining 
Windows Vista users are stubbornly hanging onto their equipment, it appears that those moving on are sticking with 
Windows. 
 

ComputorEdge 1/13/12

7 of 40



 
Figure 1. Desktop operating systems' market share (Net Market Share).

 
 
As for Macintosh, while Apple has increased its market share significantly, it started at such a small percentage of total 
desktop installations that it will takes years—if not decades—for the Mac to pose a real threat to Windows dominance. 
None of this speaks to the quality of operating systems (except maybe Windows Vista). Many people will argue that 
the Apple Mac is a superior computing platform, but even if true, it may not matter. With the possible exception of the 
tablet, the computer market is no longer a new fast growing market. People tend to stick with what they know—even 
(or especially) when they are mathematically proven to be wrong. 
 
Linux is here to stay, but mostly in the server and cloud market. Businesses have found that reliable, free software is a 
tremendous benefit. It is not likely to take over the desktop computer, because even free is not enough of a cost 
savings to justify the learning curve and incompatibilities. 
 
Tablets Eroding Desktop and Laptop Computer Market? 
 
People point to the death of the Netbook computer to prove that the iPad tablet is killing the laptop and possibly the 
desktop market. With the introduction of the low-cost Amazon Fire tablet, NOOK tablet and other former eReaders, the 
problem could get worse. However, logic dictates that the tablet computer is not actually a desktop killer. If anything is 
killing the desktop, it's the laptop which is now as powerful as any desktop, plus you can take it with you. 
 
Tablets are replacing computers that were used solely for browsing the Web, reading Facebook, checking e-mail, 
reading e-books, watching Netflix and other light tasks which can be done while sitting on the sofa, in a cafe, at an 
airport, or in bed. This explains the iPad's tremendous impact on Netbook computers. While about one-third of tablet 
owners are using their computers less (blog.nielsen.com/nielsenwire/online_mobile/connected-devices-
how-we-use-tablets-in-the-u-s/) or not at all, when they have work to do they turn to their computers. That 
means that for more than 75 percent of the owners, the tablet is a supplemental computer rather than a replacement 
for desktops or laptops. 
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Figure 2. Equipment owned by tablet owners (Bizrate Insights).

 
 
Rather than displacing the traditional computer, most people bought their tablet computer to complement their desktop/
laptop computer (www.bizrateinsights.com/wordpress/wp-content/uploads/2011/05/Bizrate-Forrester-
Study-Tablet-Usage-Among-Online-Buyers.pdf) (see Figure 2). You would be hard pressed to find a tablet 
owner who doesn't also own another computer. Although tablets are now owned by ten percent (and growing rapidly) 
of the market, they are only replacing computers for people who have no need to do work. (Even writing an e-mail can 
be a pain on a tablet touch screen.) This could represent as much as twenty-five percent of the computer market, but 
done not come near wiping out the desktop/laptop market. It is more likely that the tablet market will stimulate other 
computer sales since most tablets benefit for the support of the computers USB connection. 
 
Windows 7—the New Windows XP 
 
As Windows 7 slowly surpasses Window XP this year, it will become the new staple for desktop and laptop computer 
operating systems. In the same manner as Windows XP, Windows 7 is a good operating system which will be around 
for a long time. It is more stable than Windows XP and has new features that make it well worth the upgrade. In 
particular, the addition of little understood Windows Libraries deals with the problems brought about by massively large 
hard drives, thousands of saved files (photos, music, videos, etc.), and files saved on a diverse group of networked 
devices. (I address Windows 7 Libraries in the e-book Windows 7 Explorer Secrets (EPUB (www.
computoredgebooks.com/Windows-Tips-and-Tricks-E-Books-EPUB-format-iPad-NOOK-
Kobo_c8.htm) for iPad, NOOK and Kobo, or MOBI (www.computoredgebooks.com/Windows-Tips-and-
Tricks-E-Books-MOBI-format-Amazon-Kindle_c9.htm) for Amazon Kindle) which is now available at 
ComputorEdge E-Books.) In spite of the fact that Windows 8 will be released this year, Windows 7 will continue 
its growth for many years to come—primarily due to the decline of Windows XP and what's left of Windows Vista. 
 
(This is one of the reasons that I'm retooling the hundreds of Windows Tips and Tricks I wrote for Windows 7 e-books. 
I expect that Windows 7 will need support for quite a few more years, plus the e-book format will only grow as the 
tablet market continues to explode. In addition to the current Windows 7 Taskbar and Explorer e-books, I have plans 
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for e-books on Windows 7 troubleshooting, free utilities, speed computing, the Desktop and Start Menu, multimedia, 
and unusual Windows tips and tricks.) 
 
Windows 8 
 
Scheduled to be released later this year (nvonews.com/2012/01/03/windows-8-release-date-getting-
closer-will-come-with-great-features/), Windows 8 is not likely a real replacement for Windows 7. It is being 
touted as the be-all and end-all of operating systems, but most likely it is trying to do too much. Windows 8 is actually 
Microsoft's target at the tablet market. The built-in touch interface is essential for a tablet computer, but a minor issue 
for desktop/laptop computers. This is why Steve Jobs never incorporated touch screens into Macs. Windows 8 is 
supposed to be flexible to do everything for both traditional computers and tablets. (See an overview of Windows 8 in 
this article from last year.) 
 

 
Figure 3. The look of the Windows 8 interface.

 
 

Ever since the Windows Vista fiasco, people 
remain skeptical of any new operating system 
from Microsoft. Windows 8 will enter without 
much excitement and it will need to prove itself. 
In the meantime, Windows 7 with continue its 
growth in the market. If Microsoft is smart (this 
behavior cannot be predicted), then they won't try 
to push Windows 8 as the Windows 7 
replacement—maybe as an alternative. Windows 
7 has now been around long enough to be 
considered a proven quantity. If it is now gaining 
acceptance—which Windows 7 is—then 
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Microsoft should be careful how they handle it—
which they probably won't. 
 
In any case, much of this is out of Microsoft's 
hands. The market will decide what it wants—and 
do it in its own good time. It's hard to say what 

will happen with Windows 8, but it looks like Windows 7 will be here for a long time—at least in computer years.
 

Jack is the publisher of ComputorEdge Magazine. He's been with the magazine since first issue on May 16, 1983. 
Back then, it was called The Byte Buyer. His Web site is www.computoredge.com. He can be reached at 
ceeditor@computoredge.com. Jack is now in the process of updating and compiling his hundreds of articles and 
columns into e-books. Currently available: 
 
Windows 7 Explorer Secrets (EPUB for iPad, NOOK, etc.) (www.computoredgebooks.com/Windows-7-
Explorer-Secrets-EPUB-for-iPad-NOOK-etc-Wintips0003-1.htm) 
Windows 7 Explorer Secrets (MOBI for Amazon Kindle) (www.computoredgebooks.com/Windows-7-
Explorer-Secrets-MOBI-for-Amazon-Kindle-Wintips0003-2.htm) 
Windows 7 Taskbar Secrets (EPUB for iPad, NOOK, etc.) (www.computoredgebooks.com/Windows-7-
Taskbar-Secrets-EPUB-for-iPad-NOOK-etc-Wintips0002-1.htm) 
Windows 7 Taskbar Secrets (MOBI for Amazon Kindle) (www.computoredgebooks.com/Windows-7-
Taskbar-Secrets-MOBI-for-Amazon-Kindle-Wintips0002-2.htm) 
Sticking with Windows XP—or Not? (EPUB for iPad, NOOK, etc.) (www.computoredgebooks.com/
Sticking-with-Windows-XP-or-Not-EPUB-for-iPad-NOOK-etc-Wintips0001-1.htm) 
Sticking with Windows XP—or Not? (MOBI for Amazon Kindle) (www.computoredgebooks.com/Sticking-
with-Windows-XP-or-Not-MOBI-for-Amazon-Kindle-Wintips0001-2.htm)  
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Windows 7 Explorer 
Tips and Tricks
“Windows Explorer 
Has More Power in 
Windows 7” by Jack Dunning 
 

Windows Explorer has always 
been the primary navigation tool 
for Windows. Now with the 
addition of Libraries and 
HomeGroup, Windows 7 offers 
new tools for getting organized 
and sharing over networks. 
Personalize Windows Explorer for 
your computing.

 
 
Windows Explorer is the primary utility for navigating and browsing through files on your computer. It has been around 
since the beginning, and anyone who has used any version of Windows is probably well acquainted with the file-
exploring program. In Vista, the look and feel changed slightly with the addition of Favorites and a new menu across 
the top. These changes were not always met with the approval of older Windows users. In Windows 7 the new look is 
more like Vista than XP, but with two new functions: Libraries and HomeGroup. In conjunction with Favorites added in 
Vista, Libraries and HomeGroup are important features for locating and sharing files. Plus, there are more layout 
options that will make it easier to view and sort through your files. 
 
Why do we need more ways to navigate our computer? Because hard drives have gotten too big and we are putting so 
many computers on networks. Both of these are great for increasing storage capacity and sharing between computers, 
but it has become much harder to find our way around hard drives and networks—even when we think we are highly 
organized. Windows 7 has included Favorites, Libraries and HomeGroup to make navigating and sharing easier. The 
problem is uncovering how to make the best use of them. 
 
Windows Explorer in Windows 7 
 
In Windows 7 Windows Explorer has five default categories: Favorites, Libraries, HomeGroup, Computer and Network 
(see Figure 1). "Computer" equates to the old Windows XP Windows Explorer view with the tree structure of folders 
and files. Favorites was an XP option which appeared in the menu bar at the top. (Note that the Windows XP menu 
bar "File-Edit-View-Favorites-Tools-Help" does not appear at the top of this view. You can temporarily restore it by 
pressing the ALT key.) 
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Figure 1. Windows Explorer in Windows 7 includes Favorites, Libraries, HomeGroup, Computer and Network. Click Computer to 

see the folder/file structure tree similar to Windows Explorer in Windows XP.
 
 
In Windows Vista, Favorite Links was added to the Navigation pane and the old XP structure was found in Folders—a 
collapsible option. In addition, a Details pane was added at the bottom and a Preview pane was added at the right. 
Both of these continue in Windows 7. Also, by default the menu bar was hidden in Windows Vista. 
 
Note: There is a Search field in the upper right hand corner of Window Explorer. This was first introduced in Windows 
Vista for searching the titles and contents of specific folders. It works in the same manner as the search in the Start 
menu except that it is localized to the current folder and subfolders. 
 
Favorites 
 
I first started using Favorites in Windows Explorer with Windows Vista. Each week I changed one of the Favorites 
shortcuts to the folder for the new issue. I've found that this is one of the best ways to maintain quick access to the 
folders and files while always keeping all that I need at hand. 
 
Libraries  
 

ComputorEdge 1/13/12

13 of 40



Windows 7 has added Libraries for tracking collections of similar types of files across many different devices and 
computers—whether music, photos, videos or documents. Libraries give you one location for all similar files—even if 
they are on different drives and computers. This saves you from needing to copy all of the files to your computer for 
use. 
 
HomeGroup 
 
The new HomeGroup feature is all about sharing with other Windows 7 computers. Entire Libraries can be easily 
shared with other members of the HomeGroup regardless of the original location. 
 
Changing the Windows Explorer Window 
 
There are a few different ways to open Windows Explorer. If you hold down the Microsoft flag key and hit the letter E 
(WIN+E) or click the Start Menu and select Computer, Windows Explorer will open a window with Computer selected. 
If you select Start/All Programs/Accessories/Windows Explorer, a window will open with the Documents folder 
selected. The primary difference between the two is that you have system options in the options bar when you select 
Computer. This options bar changes depending upon the type of folder you have open. 
 
It is possible to remove each of the Navigation, Details and Preview panes by selecting Organize => Layout and 
unchecking them. (Also the old menu bar can be permanently added back by checking "Menu bar" in the same menu.) 
You would only do this if you needed to maximize the space for viewing files. Figure 1 shows Windows Explorer with 
no special panes implemented. In the Details view mode, a good deal of information can be displayed, but, as in this 
situation, it can be pretty nondescript. 
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Figure 2. Windows 7 Details view in Windows Explorer with no panes opened. The view of the files can be change by clicking 

the "Change your view" button at the upper right (circled).
 
 
(In Windows Vista there was a method for changing Windows Explorer back to the classic XP look in Folder Options, 
but that merely removed capabilities. The retro option is available in Windows 7, but it needs to be set by right-clicking 
on the Desktop and selecting Personalize. Then select Windows Classic from the Basic and High Contrast Themes. 
This will affect the look of the Desktop as well as all windows.) 
 
The display of the three panes (Navigation, Details and Preview) is controlled through Organize => Layout, as shown 
in Figure 3. If checked, each pane will appear. If left unchecked, the respective pane will be removed. 
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Figure 3. Layout options in Windows Explorer in Windows 7. All panes and the Menu bar have been added to the window.

 
 
The standard Navigation pane which includes Favorites, Libraries, Homegroup, Computer and Network is located on 
the left side of the window, just as in Windows XP and its predecessors. The Navigation pane continues to be the best 
tool for moving about your computer system—whether using the Computer folder/file tree structure, Favorites, 
Libraries, or another of the Windows 7 features. 
 
A particularly useful feature, especially if you're sorting through images, documents, video, or music files, is the 
Preview pane. When a file is selected, a preview appears in the frame on the right. If you select one of the standard 
image file formats, the image will appear (as seen in Figure 3). If you pick a document, the contents of the document 
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will show in the right-hand Preview pane. For music and videos, a play button will be offered. 
 
For more information on each file, the Details pane, not to be confused with the Details view selected from the View 
menu, can be added at the bottom of the window. Depending upon the type of file, there is a great deal of metadata 
that can be read and/or added in this pane. The function of the Details pane and the associated file metadata have 
been the subject of past Windows Vista columns which have been updated for the now available e-book Windows 7 
Explorer Secrets (EPUB (www.computoredgebooks.com/Windows-7-Explorer-Secrets-EPUB-for-
iPad-NOOK-etc-Wintips0003-1.htm) for iPad, NOOK and Kobo, or MOBI (www.computoredgebooks.
com/Windows-7-Explorer-Secrets-MOBI-for-Amazon-Kindle-Wintips0003-2.htm) for Amazon Kindle). 
 
Customizing Windows Explorer Behavior 
 
In June I noted the following "Digital Dave" letter in ComputorEdge: 
 
Dear Digital Dave, 
 
I've used a Windows XP computer for years and recently bought a new Windows 7 computer. 
The experience has made me want to go back to XP. I used to be able to use Windows Explorer 
to navigate through the tree of folders and files. Now, whenever I click to open a folder, a new 
window of Windows Explorer opens on top of the current folder. This is annoying. Why does 
Windows 7 do this? Also, I used to be able to see the file extensions, but now I can't. 
 
Jim, Escondido 
 
There are many minor, yet disconcerting, differences in Windows 7 until you get set up the way you want and grow 
accustomed to the new way of doing things. In Jim's situation it was a setting (which also exists in Windows XP and 
Vista) in the Folder Options window (see Figure 4). The Folder Options window is opened by selecting Organize => 
Folder and search options. You can also select "Folder options..." from the Tools menu if the classic Menu bar is in 
view. (If not in view, the ALT key will activate the classic Menu bar.) 
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Figure 4. The Windows 7 Folder Options window with the General tab selected.

 
 
Jim wants to select "Open each folder in the same window" in the "Browse folders" category to return to his usual 
practice of working with just one window. 
 
In the same Folder Options tab, you can control how you want to each folder/file to respond to your mouse. If you 
relish a little more speed and want to cut your clicks in half, select "Single-click to open an item (point to select)" from 
"Click items as follows." If you want to see more detail in the initial Navigation Pane, check "Show all folders." 
 
In the View tab of the Folder Options windows there are a number of settings which will control how Windows Explorer 
will behave (see Figure 5). You should scroll through the list and test those that look helpful. The changes you make 
will only apply to the current folder unless you click "Apply to Folders," in which case all folders of the same type will be 
set to the same behavior. 
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Figure 5. The Windows 7 Folder Options window with the View tab selected.

 
 
Windows Explorer Searches 
 
The Search field in the upper right hand corner of Windows Explorer was new in Windows Vista and continues in 
Windows 7. Searches in Windows Explorer are very similar to those conducted from "Search programs and files" in 
the Start Menu except that they are limited to the current folder and its subdirectories. These searches will scour both 
titles and contents of files. The behavior of these searches in Windows Explorer is controlled through the Search tab of 
the Folder Options window (see Figure 6). 
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Figure 6. The Windows 7 Folder Options window with the Search tab selected.

 
 
Windows Explorer is one of the most important tools in Windows. It gives us a way to navigate our system of folders 
and files. Windows 7 has added some important new features which when tailored to the situation will make computing 
life much easier. For everyday use, Favorites and Libraries will easily locate and open the most needed documents, 
photos, music and videos. If there are multiple Windows 7 computers on a network, the HomeGroup is a excellent way 
to share. 
 
If you would like to learn more about Windows 7 Explorer, a series of Windows 7 Tips and Tricks columns have been 
compiled and updated in the new e-book Windows 7 Explorer Secrets (EPUB (www.computoredgebooks.
com/Windows-Tips-and-Tricks-E-Books-EPUB-format-iPad-NOOK-Kobo_c8.htm) for iPad, NOOK 
and Kobo, or MOBI (www.computoredgebooks.com/Windows-Tips-and-Tricks-E-Books-MOBI-format-
Amazon-Kindle_c9.htm) for Amazon Kindle). It is available at ComputorEdge E-Books (www.
computoredgebooks.com).
 

Jack is the publisher of ComputorEdge Magazine. He's been with the magazine since first issue on May 16, 1983. 
Back then, it was called The Byte Buyer. His Web site is www.computoredge.com. He can be reached at 
ceeditor@computoredge.com. Jack is now in the process of updating and compiling his hundreds of articles and 
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columns into e-books. Currently available: 
 
Windows 7 Explorer Secrets (EPUB for iPad, NOOK, etc.) (www.computoredgebooks.com/Windows-7-
Explorer-Secrets-EPUB-for-iPad-NOOK-etc-Wintips0003-1.htm) 
Windows 7 Explorer Secrets (MOBI for Amazon Kindle) (www.computoredgebooks.com/Windows-7-
Explorer-Secrets-MOBI-for-Amazon-Kindle-Wintips0003-2.htm) 
Windows 7 Taskbar Secrets (EPUB for iPad, NOOK, etc.) (www.computoredgebooks.com/Windows-7-
Taskbar-Secrets-EPUB-for-iPad-NOOK-etc-Wintips0002-1.htm) 
Windows 7 Taskbar Secrets (MOBI for Amazon Kindle) (www.computoredgebooks.com/Windows-7-
Taskbar-Secrets-MOBI-for-Amazon-Kindle-Wintips0002-2.htm) 
Sticking with Windows XP—or Not? (EPUB for iPad, NOOK, etc.) (www.computoredgebooks.com/
Sticking-with-Windows-XP-or-Not-EPUB-for-iPad-NOOK-etc-Wintips0001-1.htm) 
Sticking with Windows XP—or Not? (MOBI for Amazon Kindle) (www.computoredgebooks.com/Sticking-
with-Windows-XP-or-Not-MOBI-for-Amazon-Kindle-Wintips0001-2.htm)  
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Wally Wang's Apple Farm
“Barnes & Nobles on the Edge” by Wally Wang 
 

Barnes & Nobles on the Edge; The Consumer Electronics Show 
(CES); Macs in the Enterprise; The Origins of Windows Phone 7; The 
TED App for the iPhone/iPad; Smartphone Market Share; The 
Duplicate Command.

 

 
Back in the '90s, Barnes & Noble and Borders could open massive bookstores and drive independent book sellers out 
of business. Nowadays, Borders is gone and Barnes & Noble is following closely behind, which suggests that Borders' 
fate wasn't just through mismanagement but through the decline of printed books in general.  
 
To save themselves, Barnes & Noble is thinking about selling off their Nook e-book business, which is the only part of 
the company currently making money. Yet The Wall Street Journal (online.wsj.com/article/
SB10001424052970203513604577142481239801336.html?mod=googlenews_wsj) reports that 
"Ironically, Barnes & Noble had been one of the first to recognize the potential of digital books. In 1998, it invested in 
NuvoMedia Inc., maker of the Rocket eBook reader, and the bookseller actively supported digital-book sales. But in 
2003, it exited the still-nascent business, saying there wasn't any profit in it." 
 
Like most companies, Barnes & Noble couldn't see why they should invest for the future, so they chose the easier path 
of simply focusing on profits right now. With Borders gone and Barnes & Noble's aging bookstores threatening to 
disappear soon, the entire book business is going through a radical change like the music industry. Very few chain 
music stores exist any more and pretty soon they'll be as rare as chain bookstores.  
 
With the entire printed book distribution network practically wiped out, traditional publishers are struggling to sell their 
books. One short-sighted solution is to raise their e-book prices to equal or exceed the price of printed books. Most 
likely publishers like Random House, John Wiley and Doubleday will simply fade away over time like Sears, Kodak 
and other former corporate icons. 
 
For authors, the demise of traditional publishers can actually be a relief. No longer do you need to get past the 
publishing gatekeepers to get your book published. Now you can just do it yourself. Even better, instead of giving up 
the rights to your book along with taking a measly 10-15% of the profits based on the price the publisher sells a book 
to a distributor (who then sells the book to a bookstore), self-publishing gives you 65% - 70% of the profits based on 
the retail price of the book, plus you get to keep all the book rights as well. 
 
For a $10 book, that means if you self-publish, you get 70% or $7 a book. If you go through a traditional publisher, the 
bookstore sells the printed book for $10, but they bought it from a distributor for $5, who bought if from the publisher 
for $2.50, so you get 10% or 25 cents a book.  
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In the old days, you needed a traditional publisher who had the contacts to get your book into bookstores. With 
bookstores disappearing, there's little need for traditional publishers any more.  
 
Currently, the two most popular self-publishing programs are Amazon's Kindle Direct Publishing (kdp.amazon.com/
self-publishing/signin) (https://) and Barnes & Noble's PubIt (pubit.barnesandnoble.com/pubit_app/bn?
t=pi_reg_home). However, by the end of January, Apple may jump into the self-publishing game (goodereader.
com/blog/tablet-slates/apple-to-launch-new-self-publishing-program-later-this-month/?
utm_source=rss&utm_medium=rss&utm_campaign=apple-to-launch-new-self-publishing-
program-later-this-month). 
 
Rumors identify this end of January event as Apple's plan for digital textbooks, a self-publishing program for Apple's 
iBookstore, and an update to iWork '12 that will include tools for making it easy for authors to create e-books that 
conform to the latest EPUB 3 standard, which supports audio, video and interactivity. Such multimedia presentation 
features will help kill the first generation e-book readers that offered e-ink. 
 
MarketWatch (www.marketwatch.com/story/are-e-ink-readers-in-trouble-2012-01-05?
link=MW_latest_news) reports that sales of e-ink readers, such as the early Amazon Kindle and the latest Barnes 
& Noble Nook Simple Touch, have been plummeting. Like the early Amazon Kindle ads highlighted, e-ink readers are 
great for reading books in bright sunlight. However, that's all they're good for since they can't display video or offer 
interactivity of any kind. If you just want to read static text, e-ink reigns supreme. If you want to go beyond static text, 
you'll need a tablet like the iPad or Amazon Kindle Fire.  
 
To be an author of the future, you'll have to do more than just write. You'll need to understand how to effectively 
present information in audio, video and interactive formats. In the '80s, Bantam Books used to publish a series of 
children's books called Choose Your Own Adventure where the book presented you with different choices and based 
on your decisions, the story took you one way or another.  
 
These Choose Your Own Adventure books were fun, but somewhat clumsy since you had to flip back and forth 
through pages to follow your particular story out of many possible stories. With an interactive e-book, you can let the e-
book handle this for you. 
 
Interactive fiction may be a whole new genre as traditional forms of fiction relies on a linear format such as a novel. E-
books promise new opportunities for creativity. While some may mourn the decline of printed books, keep your eyes 
on the rapid changes of e-books or you may miss out on the most revolutionary changes to distributing information 
since the printing press.  
 
The Consumer Electronics Show (CES) 
 
Two years ago at CES 2010, Microsoft highlighted various tablet PCs including Hewlett-Packards Slate 500 PC 
running Windows 7. The Slate 500 PC went on to sell approximately 9,000 copies and Hewlett-Packard has withdrawn 
all of their videos previously highlighting the device and emphasizing the years of research that they claimed went into 
creating it.  
 
Last year at CES 2011, Microsoft demonstrated Windows running on ARM processors. These devices still aren't 
available and won't be until later this year. So it's no surprise that CES 2012 will be Microsoft's last keynote for the 
event, which focused on Kinect becoming available for Windows PCs on February 1 along with more demonstrations 
of Windows 8's Metro user interface. 
 

ComputorEdge 1/13/12

23 of 40



Microsoft, like Apple, has discovered that big trade shows aren't the best way to highlight their products. Rather than 
get buried with the rest of the new gadgets being introduced at such large trade shows, Microsoft has decided they 
can host their own events that just focus on their products.  
 
With Microsoft abandoning CES after this year, the future of CES remains up in the air. It may still limp along with less 
publicity, but like the last two years, the real question isn't what Microsoft is going to do but what will Apple do. 
 
CES 2012 is already loaded with companies offering copycat versions (www.zdnet.com/blog/storage/can-
wintel-win-the-ultrabook-market/1593?tag=mantle_skin;content) of Apple products such as the iPad and 
MacBook Air. Now many companies are already anticipating Apple's TV device, just like so many companies tried to 
anticipate Apple's iPad back in 2010. With so many rumors about Apple's TV and so many companies nervous about 
the possibility, it seems probable that Apple (along with Google) may actually release a new TV set (www.
computerworld.com/s/article/9223231/How_Google_and_Apple_will_control_TV?
taxonomyId=128&pageNumber=1) later this year.  
 
If Apple's TV set does appear this year, we can all look back at the companies demonstrating TV sets at CES 2012 
just to see how they got it wrong, just like so many companies got it wrong when trying to create tablet computers at 
CES 2010 to beat the iPad. Fox News even published an article about the so-called CES curse where the most hyped 
products at CES too often turn out to be dismal flops (www.foxnews.com/scitech/2012/01/06/ces-curse-
gadget-show-has-poor-record/). With 2012, we can all see if that trend will continue. 
 
Macs in the Enterprise 
 
Forrester Research reports that Apple products like the Macintosh, iPhone and iPad are growing in the enterprise 
(www.bloomberg.com/news/2012-01-06/apple-gaining-on-microsoft-in-enterprise-sales-report-
says.html) due to bring-your-own-device rules where employees buy what they like and simply use the same device 
for both work and personal use. Not surprisingly, what most people want are iPhones and Android phones along with 
iPads and Macintosh computers. Forrester Research calls Apple the "biggest disruptive force in the computer 
equipment market." 
 
If people are bringing iPhones and Android phones to work along with iPads and Macintosh computers, that tells you 
what people want to use compared to what people are often forced to use at companies where IT departments dictate 
what "official" company tools  
 
Rather than focus on which company makes a particular product, simply evaluate what products will make you more 
productive. Then use those products regardless of the brand name of the manufacturer. If a particular product won't 
help you, then don't buy and use it. It's really that simple. If a certain product can help, then it's pointless to avoid it just 
because of the company that makes it. 
 
The likely reason why Apple products are growing in the enterprise world is simply because they're easy to use, 
especially when compared to rival products. Think of any phone before the introduction of the iPhone or Android or the 
difficulties a novice has using a Windows PC compared to using an iPad. 
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Figure 1. The iPhone continues offering high customer satisfaction.

 
 
Ultimately, any tool must produce a useful result. The greater the result, and the faster and easier it is to create that 
result, the more useful that tool will be. The more time you need to maintain or decipher complexity, the less time you 
could be doing something useful. Given a choice between choosing a product that makes your life easier or harder, 
people in corporations are learning to avoid products (www.digitimes.com/NewsShow/NewsSearch.asp?
DocID=PD000000000000000000000000022721&query=APPLE) that make life harder as the ongoing 
decline in Windows PC laptops (and the continuous increase of Macintosh laptop sales) suggests. 
 
The Origins of Windows Phone 7 
 
After taking one look at the iPhone, Microsoft realized that their old Windows Mobile operating system was obsolete. 
According to CNet, "Despite being an early player in the smartphone sector, Microsoft's effort was hobbled by software 
that featured complex on-screen menus that borrowed design cues from its desktop cousin. As insiders tell the 
newspaper, once the iPhone appeared on the scene, Microsoft executives knew that their OS would not be able to 
compete as designed (news.cnet.com/8301-1035_3-57354719-94/microsoft-exec-iphone-prompted-
windows-phone-redesign/)." 
 
By trying to cram the desktop interface of Windows into the smaller form factor of a mobile device, Microsoft failed to 
create an operating system designed to optimize the smaller form of a mobile phone. As a result, the iPhone (and later 
Android) wiped out Microsoft's early lead in smart phones. 
 
So what's Microsoft's latest strategy to catch up in the tablet market? Cram Windows 8 into tablets. While Windows 8 
will sport a new touch-screen Metro interface, it still carries the baggage of the traditional Windows desktop code along 
with it. Rather than create an operating system optimized for tablets, Microsoft hopes that shoving a desktop operating 
system, with a new pretty interface, will be the solution. 
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Windows Mobile tried to mimic the Windows desktop while remaining incompatible with real Windows programs. 
Windows 8 maintains compatibility with Windows programs while mimicking the look of a dedicated touch screen 
interface. Will this give Windows 8 tablets an advantage over the iPad or even Android tablets? If not, Windows 8 
tablets look to repeat the fate of Windows Phone 7 as coming three years too late to the market.  
 
The TED App for the iPhone/iPad 
 
TED (Technology, Entertainment, Design) is a regular conference that invites noted researchers to present ideas that 
represent new ways of thinking. While you may not always agree with the conclusions or even the topics TED 
conference speakers present, their ideas are almost always interesting, stimulating and thought-provoking, which can 
be a refreshing change of pace from the usual cynical, pessimistic and close-minded attitude of too many people you 
meet in every day life. 
 
Since you may not be able to attend any TED conferences in person, download the free TED app (itunes.apple.
com/us/app/ted/id376183339?mt=8) for the iPhone or iPad and you can view videos of the different TED talks 
at your convenience. 
 

 
Figure 2. The TED app offers different talks to watch. 

 
 
Browse through the various videos and tap the ones that interest you and you can get a free education in new 
research. Most videos are relatively short, such as 15 minutes in length, so you can browse through various TED talks 
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quickly. 
 

 
Figure 3. You can watch an individual TED conference talk as a short video.

 
 
If you aren't sure which TED talk to watch, ask yourself what type of feeling you want to experience. The TED app can 
show you just those videos that are funny, beautiful, inspiring, or courageous. By using this feature, you can use the 
TED app as a motivational tool. 
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Figure 4. The TED app can filter through its many talks depending on emotions

 
 
For many people, the TED talks will be inspiring and motivating. For others, these TED talks will challenge their pre-
conceived views of how the world should work and thus prove threatening. 
 
As Carol Dweck noted in her book Mindset: The New Psychology of Success (www.amazon.com/gp/
product/0345472322/ref=as_li_tf_tl?ie=UTF8&tag=the15minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=0345472322), people tend to adopt two views about 
themselves and the world. The first attitude is the belief that everyone's talents are fixed in stone so you can only 
reach a certain level of success based on your natural-born abilities. To avoid failure, you need to stay within your 
comfort zone and avoid anything unfamiliar and different. 
 
The second attitude is what Carol calls a growth mindset, which means that you feel you can not only grow and learn, 
but you can shape and control your destiny. People with a growth mindset cope with problems by constantly trying to 
improve. People with a fixed mindset cope with identical problems by blaming others and looking for excuses to avoid 
trying anything new. As a result, people with a fixed mindset tend to avoid learning anything while expending an 
enormous amount of energy to discourage others from learning anything new as well. 
 
In the world of computers, a fixed mindset will likely resist anything unfamiliar (like Apple products). On the other hand, 
a growth mindset will simply look for anything that can improve their work and their life. So which mindset do you think 
will help you in the future? 
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Smartphone Market Share 
 
According to the latest results from the NPD Group, sales of iPhones and Android phones continue to dominate with 
rivals like Windows Phone 7 and Blackberry far behind. Perhaps less surprising is the sudden jump in sales 
(techcrunch.com/2012/01/09/ios-marketshare-up-from-26-in-q3-to-43-in-octnov-2011/) of the iPhone 
with a corresponding dip in Android sales. 
 

 
Figure 5. The iPhone and Android dominate the smartphone market.

 
 
Many people like to boast that high Android sales mean that Android is superior to the iPhone. Yet this comparison 
isn't quite accurate as the iPhone had been stuck on just one carrier (AT&T) in the United States while Android has 
been available on all carriers. Now that the iPhone is available on AT&T, Verizon and Sprint in the United States, it's 
fairer to compare sales.  
 
If the NPD Group chart is any indication, the iPhone and Android are nearly equal. Over time, we'll see if Android sales 
continue to drop and iPhone sales continue to rise. Then we'll be able to tell for sure whether Android grew simply 
because it was available on more carriers or because it truly represented a superior alternative over the iPhone. 
 

*                    *                    *
 
Normally you can copy a file in the Finder window by clicking on that file, selecting Edit => Copy, then choosing Edit 
=> Paste. However, a simpler method is to right-click on the file you want to copy and when a pop-up menu appears, 
choose the Duplicate command.  
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Figure 6. The Duplicate command lets you copy and paste a file in one step.

 

In the early days, before Wally became an Internationally renowned comedian, computer book writer, and generally 
cool guy, Wally Wang used to hang around The Byte Buyer dangling participles with Jack Dunning and go to the gym 
to pump iron with Dan Gookin.  
 
Wally is responsible for the following books: 
 
My New Mac, Lion Edition (www.amazon.com/gp/product/1593273908/ref=as_li_tf_tl?
ie=UTF8&tag=the15minmovme-20&linkCode=as2&camp=217145&creative=399373&creativeASIN=1593273908) 
My New iPad 2 (www.amazon.com/gp/product/159327386X/ref=as_li_tf_tl?ie=UTF8&tag=the15minmovme-
20&linkCode=as2&camp=217145&creative=399373&creativeASIN=159327386X) 
Steal This Computer Book (www.amazon.com/gp/product/1593271050?ie=UTF8&tag=the15minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=1593271050) 
Microsoft Office 2010 For Dummies (www.amazon.com/gp/product/0470489987?
ie=UTF8&tag=the15minmovme-20&linkCode=as2&camp=1789&creative=9325&creativeASIN=0470489987) 
Beginning Programming for Dummies (www.amazon.com/gp/product/0470088702?
ie=UTF8&tag=the15minmovme-20&linkCode=as2&camp=1789&creative=9325&creativeASIN=0470088702) 
Beginning Programming All-in-One Reference for Dummies (www.amazon.com/gp/product/0470108541?
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ie=UTF8&tag=the15minmovme-20&linkCode=as2&camp=1789&creative=9325&creativeASIN=0470108541) 
Breaking Into Acting for Dummies with Larry Garrison (www.amazon.com/gp/product/0764554468?
ie=UTF8&tag=the15minmovme-20&linkCode=as2&camp=1789&creative=9325&creativeASIN=0764554468) 
Strategic Entrepreneurism with Jon and Gerald Fisher (www.amazon.com/gp/product/1590791894?
ie=UTF8&tag=the15minmovme-20&linkCode=as2&camp=1789&creative=9325&creativeASIN=159079189) 
How to Live with a Cat (When You Really Don't Want To) (www.amazon.com/gp/product/B006DJYL70/
ref=as_li_tf_tl?ie=UTF8&tag=the15minmovme-
20&linkCode=as2&camp=217145&creative=399373&creativeASIN=B006DJYL70) 
The Secrets of the Wall Street Stock Traders (www.amazon.com/gp/product/B006DGCH4M/ref=as_li_tf_tl?
ie=UTF8&tag=the15minmovme-20&linkCode=as2&camp=217145&creative=399373&creativeASIN=B006DGCH4M) 
Mac Programming For Absolute Beginners (www.amazon.com/gp/product/1430233362?
ie=UTF8&tag=the15minmovme-20&linkCode=as2&camp=1789&creative=9325&creativeASIN=1430233362) 
99% Fairy Tales (Children's Stories the 1% Tell About the Rest of Us) (www.amazon.com/gp/product/
B006QSKM3A/ref=as_li_tf_tl?ie=UTF8&tag=the15minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=B006QSKM3A) 
The Zen of Effortless Selling with Moe Abdou (www.amazon.com/gp/product/B006PUFPGI/ref=as_li_tf_tl?
ie=UTF8&tag=the15minmovme-20&linkCode=as2&camp=1789&creative=9325&creativeASIN=B006PUFPGI) 
The 15-Minute Movie Method (www.amazon.com/gp/product/B004TMD9K8/ref=as_li_tf_tl?
ie=UTF8&tag=the15minmovme-20&linkCode=as2&camp=1789&creative=9325&creativeASIN=B004TMD9K8)  
 
In his spare time, Wally likes blogging about movies and writing screenplays at his site "The 15 Minute Movie 
Method." (www.15minutemoviemethod.com/ ) Wally can be reached at wally@computoredge.com.
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Beyond Personal 
Computing
“Gamers And Gaming: In 
Love With An Alternate 
Reality” by Marilyn K. Martin 
 

Marilyn shares amusing anecdotes about 
gamers and their video games.

 

 
How To Know You're Addicted To Video Games: 
 
1. You learned Japanese just so you can play more games. 
 
2. You don't talk about anything but games. 
 
3. Your soul-mate loves gaming as much as you do. 
 
4. When you invite other online gaming players you don't know to your wedding. 
 
5. You look for a map when you are going to take a walk in a forest. 
 
6) When something bad happens, you reach for the Pause button. 
 
7. You dream about gaming. 
 
8. You ask your doctor how many lives you have left. 
 
Games From the Void 
 
Then there was the young man, new to computers, who thought that all computers were good for was playing video 
games. When he spent $20 on a computer game that sounded interesting, he couldn't get it to install on his PC. He 
called a friend, who walked him through another failed installation. 
 
"So what's the name of this new game, anyway?" his frustrated friend asked. "Fonts," answered the guy cheerfully. 
"And every file is all the letters of the alphabet." The friend had to gather his composure, since he knew his friend didn't 
even have a word processor package on his computer yet. "Uh, 'Fonts' isn't a game, dude. It's a program of different 
scripts, or types of letters ..." 
 
Tricky Add-Ons and Extensions 
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One Help Desk got a call from a customer who asked, "I need a pair of 3D glasses to play my 'Turok Dinosaur Hunter' 
game." The Tech tried to be polite, "Uh, you don't need 3D glasses to play that game, Sir." But the customer was 
insistent. "But it says, 'Required 3D Accelerator.' Isn't that the same as 3D glasses?" 
 
Another customer approached a salesman in a computer store in the upgrades department. She insisted she needed 
a "card game." The salesman was unsure. "A card game? Like poker?" The customer started over. "No. I just bought a 
steering wheel. And it says I need a card game." 
 
The salesman was momentarily baffled, how a steering wheel could possibly work in a card game. Then he figured it 
out. "Oh! You mean a 'game card,' to plug in your steering wheel. They're in aisle 10 with steering wheels." 
 
So Exactly What Crashed? 
 
Then there was the customer who called Tech Support to complain that "My computer crashed! It won't let me play my 
game!" The Tech gave him instructions to reboot. "No, it didn't crash," insisted the user, "IT crashed." After a few 
troubleshooting questions, the Tech realized that the user was playing 'Lunar Lander' and had crashed his game's 
spaceship. "Click on File, and then New Game," the Tech instructed. "Wow!" the user gushed a few seconds later. 
"How'd you learn how to do that?" 
 
So People Actually Read License Agreements? 
 
A customer called a company that sold an add-on for a popular flight simulation game. She was very concerned about 
a message she'd just read telling her she needed a license in order to fly any of the planes in the game. The Tech was 
totally baffled, until he realized that she was referring to the License Agreement that comes with almost all commercial 
software. He explained that No, they just needed her to agree not to resell the product without a license. 
 
A Woman's Perspective On Her Man's Gaming Obsession 
 
1. If he can afford an Xbox, he can afford to take me out some place nice for dinner. 
 
2. Is your gaming coming between us? 
 
3. Did you just take our son out of school to 'even up the odds' in your online gaming tournament? 
 
6. So if your parents used the Entertainment Theory to raise you, why didn't you become a clown instead of a hard-
core gamer?  
 
7. Are you playing a video game while you're talking to me on the phone? 'Cause I know I'm not "that bitchin' woman in 
leather with a sword." 
 
8. He loves that PlayStation more than me! 
 
9. No, I don't think it's funny that you just bought our newborn a onesie that says "Conceived When The Power Was 
Out And I Couldn't Play My Video Games." 
 
Video Games To Play With Your Pet 
 
Check out this Web site (neveryetmelted.com/categories/7/games/) for a short but hilarious video of an 
Australian pet lizard playing "Ant Smasher" on the touchscreen of a tablet computer. 
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There are also some YouTube videos and personal anecdotes from dog owners about their pets interacting with Kinect
—or just reacting to their wildly flailing owners. Another video (on flirp.net) shows a kick-boxing human on Kinect, 
when his cat wanders into the room. The guy accidentally sends his cat flying into the air with a kick! (The cat walked 
away, so no serious harm was done.) 
 
Of Course I'm Serious! 
 
1. We could have won the war in the MidEast long ago if we'd have dropped video games on the enemy. 
 
2. They need to invent a game using all the characters killed in video games. 
 
3. If my life was a video game, I'd be an Ultra Exterminator for the Occupy Movement—and have a hundred girlfriends 
in every state. 
 
4. Are there any niche anger management classes for "gamer rage"?  
 
5. If I learned to fight from watching video games, shouldn't I get a million Life Extension Points when I win a fight? 
 
6. You know you've been playing Halo too much, when the weatherman on TV announces flood risks and you get out 
a shotgun. 
 
7. You know you've played too much Call of Duty when you think the UPS guy is trying to plant C4 on your doorstep. 
 
More Ways to Tell If You Are Addicted to Video Games 
 
1. All the music on your iPod came from Guitar Hero. 
 
2. When you get physically hurt, you just hide behind something for a few seconds until you "heal." 
 
3. You name your child after a video game character. 
 
4. Your smartphone's ringtone is from your favorite video game. 
 
5. You actually camped out 24 hours before a new game/system went on sale. 
 
6. You eat a mushroom hoping to grow bigger. 
 
7. You've tried to dial a cheat-code on your phone. 
 
8. When you refer to your car as your "epic mount." 
 
9. You have the video game hotline on speed dial. 
 
10. You refuse to go outside anymore, due to the "tacky graphics, poor sound quality and low playability." 
 
Something Lost in Translation 
 
Back when the best video games were coming out of Japan, their translated lines into English were sometimes 
unintentionally hilarious. (All misspellings are the way they appeared in the games.) 
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"A winner is you!" 
 
"This room is an illusion and is a trap devisut by Satan. Go ahead dauntlessly! Make rapid progres!" 
 
"Congratulation. This story is happy end." 
 
"I feel asleep!!" 
 
"They had the gloriest days for two centuries...It was living and was destroying all other civilizations...But as the Air 
Fortress had very high potential, the defence force was wiped out in vain." 
 
"This is not enough Golds." 
 
"You are the very prevailer that protect right and justice...Take good rest!" 
 
"Shine Get!" 
 
"You can't give it up! Triumph or die!" 
 
"Now go and rest our heroes!" 
 
Worst Video Games Ever 
 
Hard-core, life-long gamers all have their own "worst video games" list. I've culled these titles from many online lists, 
since the titles alone reek Horrrrrrrible! 
 
"Super Columbine Massacre RPG" 
 
"Custer's Revenge" 
 
"The Typing of the Dead: Type or Die" 
 
"The Howard Dean for Iowa Game" 
 
"Extreme Sports With The Berenstein Bears" 
 
"Skate or Die" 
 
"Elevator Action" 
 
"You Are Empty" 
 
"The Island of Dr. Frankenstein" 
 
"Irritating Stick" 
 
"Crypt Killer" 
 
"Fairytale Fights" 
 
War Games And The Geneva Convention 
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Lastly, the gaming community is closely following the International Committee of the Red Cross, who is reportedly 
studying video war games to see whether they violate the Geneva Conventions (kotaku.com/5863817/war-
crimes-in-video-games-draw-red-cross-scrutiny). The Geneva Conventions were established in 1949 to 
dictate that POWs, wounded/sick fighters, civilians and so on "be treated with dignity and not be made subject to 
torture or other forms of excessive violence." 
 
Notable laws, but should they be applied to video games with fictional characters? The 31st International Conference 
of the Red Cross and Red Crescent met in Geneva, Switzerland in December 2011, and held a side event to "discuss 
the influence video games have on public perception and action." All that was decided was that "something" should be 
done, but so far, no details on what those actions should be. 
 
(Most of these amusing anecdotes are on multiple online joke sites. But special thanks to Rinkworks.com, 
Complex.com, and 11points.com.)
 

Marilyn is a freelance writer and humorist with many interests. She has sold teen anti-drug articles, as well as had 
numerous esoteric articles published. She has almost seventy mini-articles on Helium.com (www.helium.com/
users/573405/show_articles), and is writing a humorous Young Adult Science Fiction series, Chronicles of 
Mathias. Volumes One and Two have received a "Gold Star for Excellence" from TeensReadToo.com (www.
teensreadtoo.com/ReptilianRebirth.html), and are available from most on-line bookstores.
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Editor's Letters: Tips and Thoughts 
from Readers
“Computer and Internet tips, plus comments 
on the articles and columns.” by ComputorEdge 
Staff 
 

"Touchscreen Steering Wheel and Jawbone Up," "Cutting the E-
cable," "E-books, Print-on-Demand, and More"

 
 
Touchscreen Steering Wheel and Jawbone Up 
 
[Regarding Marilyn K. Martin's December 23 article, "Back Pocket Dialing, Smoking Smartphones, and Virtual Tours":] 
 
Many problems with this, including driver cannot keep eyes on road! Must change eye focus from infinity (distant 
vision), to look at near object, and look down from view out windshield, to place attention on complex display. Better to 
have "on windshield" or "head-up display" with focus at infinity like used by fighter pilots, with simplified graphics, 
which will also avoid problem as in your picture with reflections obscuring display. 
 
-Bill, Encinitas, CA 
 
Thanks for your comments, Bill. I think the designers were trying to keep drivers' focus on the 
road, with thumb gestures to turn on the radio, etc., and not distract them. If nothing else, it's 
another piece of the puzzle toward partially self-driving cars. 
 
-Marilyn, Texas  
 
Just an FYI in regards to the Jawbone Up fitness band—production has been halted and refunds offered to existing 
users (techcrunch.com/2011/12/08/jawbone-cancels-all-pending-up-orders-refunds-unhappy-
owners-even-if-they-keep-it/). 
 
-Chris, San Digeo / Phoenix 
 
Thanks for the update, Chris. (Do you really live in San Digeo?) 
 
-Marilyn, Texas  
 
Cutting the E-cable 
 
[Regarding the December 23 Digital Dave column:] 
 
Manny and Dave: 
 
Unsubscribing from a cable/Satellite TV service, the hot topic for years. We terminated our cable TV service 1.5 years 
ago. We don't miss the 1200 channels of programming, DVR Service, or On-demand features. 
 
We have had DVR machines in our home since 2000 (ReplayTV's) and except for live news and the occasional sports 
game we never watch "live" TV. We can still find many of the shows we wish to view through the channels' online site. 
This saves us $70/month. 
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If you are thinking of going with broadcast, start with www.antennaweb.org to see what channels you can expect 
to receive in your area. Our home is shielded by a large land mass, so the local NBC station sometimes has a weak 
signal, depending on weather. 
 
As for speed of your current ISP, fire up current streaming services, NetFlix, YouTube, Hulu, Amazon are just a few of 
the ones we use. Watch a few shows this way in full-screen mode and see if your bandwidth is sufficient. 
I wired my home with CAT-5e years ago. I started with 100MB hubs and switches, but converted to 1Gb—however 
most of our in-home network traffic is via 802.11G/N Wi-Fi, so the 100Mb speed is OK. Plus consider a move from a 
1.5 Mbs to a 3Mbs ISP service will still be far lower than even the 802.11b Wi-Fi standard. So your Internet connection 
will always be the limit/bottleneck, though you may never see it. 
 
I used various DVR software products, BeyondTV, Sage, etc when looking to replace my ReplayTV's, but in the end I 
bought a mid-range Lenova SFF desktop for under $400 and connected it to the TV. I use a SiliconDust dual ATSC 
tuner that feeds the HD signal to the Windows 7 Media Center PC via the wired network. My first HDTV antenna, a 
stick of wood and four metal hangers has been upgraded. I get full guide info (EPG) through Windows 7 Media Center 
and can record two shows at once while viewing another. 
 
Try it out with a cheap $30 USB tuner and existing equipment; then upgrade. 
 
-Stephen, San Diego, CA 
 
Not all DVRs require a service. There are units that work much like the once popular VCRs. I have two of these units 
and I think they are great (I don't understand why they aren't more popular). They have both a hard disk drive and a 
DVD recorder. You can record to or play from either as well as record from one to the other. They have a digital tuner, 
so you can connect them to an antenna and record broadcast television. 
 
Go to amazon.com and search "HDD and DVD Recorder with Digital Tuner." 
 
-Ray, San Diego, CA 
 
E-books, Print-on-Demand, and More 
 
[Regarding the December 23 Wally Wangs Apple Farm column:] 
 
If e-books cost more than hand-held, real-paper books, then the manufacturers are simply increasing inflation. Ease of 
"searching" a text is a poor excuse for price-gouging when the cost of production is less. 
 
The concept of Print-on-Demand (POD) manufacturers requiring "money up front" is simply not true in many cases. 
Some POD printers allow the author to complete the entire publication process without paying a penny. I just did this 
without any cost. 
 
-Shiva Notarajah, Tome, New Mexico 
 
As always, Wally, your column this week is interesting and thought-provoking. I agree that printed books and 
magazines are being eclipsed and largely replaced by e-things. The convenience is undeniable, and the reader apps, 
especially iBooks in my opinion, offer an excellent reader experience. Remember Jean-Luc Picard's printed 
Shakespeare? Books may yet become a luxury product. I have no problem with that.  
 
Still, the experience of selecting books online has some major shortcomings to overcome. Most important in my mind 
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is browsing. Online browsing sounds good, but is still limited compared to a well-stocked bookstore or library. I can 
take in massive amounts of information in those settings, and can find things I never knew I was looking for. The 
Dewey Decimal system and those long aisles of shelves also provide a special kind of pleasure for readers that has 
been imitated online, but nowhere near matched. In my opinion, of course.  
 
The second shortcoming of e-books, which is getting more and more important to me as I switch to using more of 
them, is the ability to lend them to others and give them away when I'm done with them. Lending or giving a book I've 
enjoyed is a great pleasure. It's much less fun to say, "Wonderful book; you should buy it."  
 
One final thing I miss when my books are "e" is the ability to have a bunch of them open at once. Not what everybody 
wants, I know, but lots of people do. Multiple cookbooks, books on a topic, poetry books, reference volumes, the list 
goes on. I can't even make up for this loss by printing out pages from my e-books in most cases. 
 
Wally, whatever you can do to steer, shove or shanghai publishers and book sellers into dealing with these problems 
will be much appreciated by this reader. 
 
-Krasna, San Diego
 

ComputorEdge always wants to hear from you, our readers. If you have specific comments about one of our 
articles, please click the "Tell us what you think about this article!" link at the top or bottom of the specific article/
column at ComputorEdge.com (webserver.computoredge.com/online.mvc?src=ebook). Your comments 
will be attached to the column and may appear at a later time in the "Editor's Letters" section.If you want to submit a 
short "ComputorQuick Review", or yell at us, please e-mail us at ceeditor@computoredge.com. If you would like 
to contribute to ComputorEdge endeavors, please visit ComputorEdge E-Books (www.computoredgebooks.
com/Contribute-to-ComputorEdge-Magazine_c3.htm).
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Send mail to ceeditor@computoredge.com with questions about editorial content. 

Send mail to cewebmaster@computoredge.com with questions or comments about this Web site. 
Copyright © 1997-2012 The Byte Buyer, Inc. 
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